Starting and Exiting WinCap

Starting/Logging-on to WinCap

To start WinCap:

A WinCap icon should be located on the desktop. Double-click on the WinCap
icon.

The following Logon prompt will appear to confirm the connection to the WinCap
Application.

Enter the WinCap User Name and Password that you have been assigned by the
System Manager. (Sheri Kershner)
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Users may also change their password anytime they wish. To initiate this
change, first enter your User Name and your current password; then right-click
on the OK button.
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Enter your new password, and then enter it again to confirm that it was entered
correctly.



You will receive the following prompt if the password was changed successfully.
Otherwise, you will receive a prompt to indicate the reason it was not changed.

Password Changed

Q Your new password now in effect,

Passwords must be at least four characters in length and must begin with a
letter. They may contain letters, numbers, spaces and punctuation characters
a2l ).

If you have forgotten your password please email or call Sheri Kershner.
(433-2613 or skershne@ocmboces.orq)

Exiting/Logging-off WinCap

WinCap runs on its own Application Server that is separate from the Local Area
Network server. Logging off the LAN does not log the user off the WinCap server.
It is very important to log off the WinCap server, not disconnect from it.
Disconnecting a session closes the connection between the server and the PC
workstation (client), but it does not log the user off. Any processes that are open
or running when a user disconnects will remain open or running. This could
interfere with other users trying to use WinCap or potentially create problems.
Therefore, it is extremely important to exit the application correctly. If there
is a concern that WinCap was not exited properly, contact Sheri Kershner
immediately.

To exit the WinCap application and log-off the server.
Using your mouse:

1) Choose File from the WinCap menu bar.
2) Choose Exit.
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The following message box will appear to confirm that the log-off from WinCap
and the Application Server is being done properly.

Exit WinCap | x|
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If you attempt to exit WinCap and receive the following message, do not select
OK. Instead, select Cancel and try again to log off WinCap again. If the problem
persists call Sheri Kershner.
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General Navigation and Data Maintenance Functions
There are two basic means for accessing the features available within WinCap:
1) Through the Menu Bar the submenus/options presented underneath it.
2) Through Toolbars that allow for the selection of specific features and

options by clicking on icons representing the available options.

Menu Bar
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The WinCap Menu Bar functions are similar to those found in other Microsoft
Windows® based applications. Users can select the appropriate options they
need from this menu.

Main Menu options are selected by clicking on the option with the mouse, or by
pressing the Alt key and typing the letter that is underlined in the name of the
option.

Submenu options are selected by clicking on the option, or by typing the letter
that is underlined in the name of the option.

The File menu is used to access administrative functions within WinCap and for
overall system operation.
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The Form menu provides choices specific to the active form window. They deal
with record maintenance and with navigation among the records accessed
through the specific form.
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The Edit menu provides options for action that can be taken on a field within a
form or for a list that is presented to select from. These options perform the
same functions they do within other windows applications.
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The Manage menu is the primary menu for accessing the options for maintaining
and processing data within the specific functional components of the WinCap
Accounting, Payroll and Human Resource Management systems.
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The Report menu is the primary menu for accessing the reporting options
available within the specific functional components of the WinCap Accounting,
Payroll and Human Resource Management systems.
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The Window menu provides options to assist the user in managing the form
windows that are open within WinCap at any particular time. In addition to the
four standard options that are listed on this menu, the user can also find a list of
all the WinCap forms that are currently open at the bottom of this menu. The
check mark denotes the active form. Selecting another window from the list will
select that form as the active form window.
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The Toolbars menu is used to activate or hide the toolbars available within
WinCap. These options function as toggles. When there is a checkmark next to
the option, the specific toolbar will be activated, otherwise it will be hidden.
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Toolbars

Toolbars provide a shortcut method to select options available within WinCap.
Instead of having to click on the Main Menu Bar and the various levels of
submenus, desired options can be directly selected by clicking on an icon found
on the toolbar. WinCap provides three different toolbars:

1) A system-defined Form Toolbar with icons representing the options found
on the Form Menu off the Main Menu Bar

2) A user-defined Application Toolbar to select the various data maintenance
Forms and processes that the user uses most often.
See example A on how to set up the Customize Application Toolbar.

3) A user-defined Report Toolbar to select the various reports the user
generates most often. See example B on how to set up the Customize
Report Toolbar.
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Example A
Setting up the user defined Application Toolbar

Choose the Icon Customize Application Toolbar.

Fii[Testacct] WinCap Yersion 03/29,/2004 - ONONDAGA-CORTLAND-MADISON BOCES
File Form Edit Manags Reports Window Toolbars Help

& | Hon] ra] <] > | o] =l e 7] | v || wkl| olestvr]

Curitemr FRecord: EQF/S Exclusive MM

Immediately the Customize Application Toolbar window will open. From the ‘View
Group’ field choose the module then highlight the program function that you want
to add to your custom toolbar, choose the Add Selected >> button, the program
will then appear in the column on the right side listing all of the programs you
have added. To remove any programs from your custom list, highlight the
program; choose the <<Remove button. When you are finished choose OK and
you will be brought back to the main screen.
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Example B
Setting up the user defined Report Toolbar

Choose the Icon Customize Report Toolbar
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Immediately the Customize Report Toolbar window will open. From the ‘View
Group’ field choose the module and highlight the report that you want to add to
your custom toolbar, choose the Add Selected >> button, the report will then
appear in the column on the right side listing all of the reports you have added.
To remove any reports from your custom list, highlight the report; choose the
<<Remove button. When you are finished choose OK and you will be brought
back to the main screen.
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Record Maintenance lcons

Ll

Fiscal Year — Click on this icon to change the fiscal year associated with

the active form window. The default fiscal year can also be set to the specified
year by checking the box provided.

Ij Change Fizcal Year
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Sat az default [

| Dk I Cancel I

Add - Select this option to add a new record based on the active form

window.

A=)

Add Similar - This option will add a record by initially copying the current
record displayed in the active form window. Key fields that must be unique
will be blanked out for the new record, so the user or system can assign a
different key value for the new record.

Modify — Where permitted; select this option to edit data in the active
form.

Save - This option will save, or post, the information entered for a new
record or the modifications made to an existing record.

Undo - This option restores data back to the status before the transaction
began. For Add, it will re-initialize the form; for Modify it will restore the
values of all fields to those last saved.

Print - This option provides a listing of system reports that are available
for the function associated with the active form window. For certain forms,
this icon will default the printing of a specific report associated with the
form, and right-clicking will default the printing of that report for the specific
record displayed in the form window. (i.e. for PO Maintenance form, left-
clicking this icon brings up the PO printing specification dialog box; right-
clicking will automatically specify the printing of the purchase order record
displayed.)
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Delete — Where permitted, this option will delete the record displayed in
the active form window. If conditions exist that restrict the users’ ability to
delete the record, then an appropriate message will be displayed.

Navigation Icons—Assist the users in accessing and displaying specific

record(s)

Go To - Provides a prompt to enter the exact value for a record that the
user wishes to display in the active form window.

Find — Use this option when the exact id code (PO#, Transaction #, etc)
for a record you wish to display is not known. It will provide a list of
records in the file those meet specified criteria from which the user can
then select the record they wish to display.

Record Order— This combo box allows the user to select the field to use
as the basis for ordering the records accessed through the Form.

ther Reference

Record Arrow Icons - Based upon the data order selected, the following
icons are used to move through the records accessed through the active
Form.

First Record - will access the "First" record in the file.
Previous Record - will access the "Previous" record in the file.
Next Record - will access the "Next" record in the file.

Last Record - will access the "Last" record in the file.

Help - An on-line help feature will be available in the future with a left click
on the ICON. Right clicking on the help button shows when the currently
displayed record was added and last modified and by what user.

Notes - For most records maintained within WinCap, there is a capability
of storing a note concerning the specific record. To add a note, the user
must be in add, add similar or modify mode. If a note is present, a letter
"A" will appear [ instead of the plain background.



EL* Exit - This option will close the active form window. If the current record
is in the Add or Modify Mode at the time this option is selected, it will
present the standard prompt whether to save the changes or not. If
cancel is selected, it will return to the active record.

Note: Icons on the Form Toolbar will appear as inactive (pale gray) if the

options are inappropriate given the status of the record in the active form
window, or if the user’s security does not permit them to perform that operation.

Workstation Lock-Ups

Sometimes a workstation may seem locked up when it actually is not. If a
workstation does seem hung, do not just turn it off.

Course Of Action: Notify your WinCap System Manager (Sheri Kershner).
Many times it's just the WinCap session that is hung up and can usually be
corrected. If a workstation is turned off without shutting down properly, especially
if the workstation really isn't hung, the user may not be able to reconnect to
WinCap. (An extra connection could have been created.) This could end up
causing a multitude of disconnected sessions on the WinCap server and slow the
system down. Also, turning the workstation off without shutting down properly
may cause severe damage to the local hard drive.



	Users may also change their password anytime they wish.  To 
	Passwords must be at least four characters in length and mus
	If you have forgotten your password please email or call She
	(433-2613 or skershne@ocmboces.org)
	General Navigation and Data Maintenance Functions
	Menu Bar
	Toolbars

	Record Maintenance Icons
	Workstation Lock-Ups


